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More info about the network and products 
This document gives a brief description of how to configure an Anybus product for LonWorks. For further 
information about the products, please consult the HMS homepage, www.anybus.com. The latest manuals 
etcetera can be downloaded from that location. 

For more information concerning the LonWorks network the LonMark International has a webpage. Please 
visit, www.lonmark.org, for more information about LonWorks. 

Document history 
Revision Date  Description Responsible 
1.00 2008-01-14 Created Thorbjörn Palm 
1.01 2008-01-25 Minor revision Thorbjörn Palm 
1.02 2008-03-13 Updated layout Thorbjörn Palm 
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1 Solution overview 
This application note describes how to configure an Anybus LonWorks module and how to set up the 
LonWorks network using the tool LonMaker for Windows. Below you can find an overview of the system 
described in this document. Other nodes may be attached to the network, but are not necessary. 

The configuration is described in two steps.  

1. At first the Anybus module configuration is explained. 

2. Secondly the configuration of the LonWorks network is described. 

Note: This document is valid for all Anybus LonWorks products, however sections written in italics describe 
the configuration of a specific product. 

The contents describe step by step how a configuration is done. This document assumes the reader is familiar 
with industrial communication, LonWorks networks and HMS Communicator and X-gateway. 
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Figure 1 Hardware connection overview. 
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2 Applicable Anybus products 
The following table specifies the relevant Anybus products for this document. 

Description Name / Type 

Anybus Communicator LonWorks 

Anybus X-gateway LonWorks 

Anybus-S  LonWorks 

Anybus-S Drive Profile  LonWorks 

3 Requirements 
The following equipment is needed to setup a successful configuration. Please note that LonMaker for 
Windows is licensed software from Echelon1. 

Description Name / Type Version 

Communicator configuration software ABC LWTool 1.06 Build 39 

Communicator configuration download ABC LWDownload 1.1 

Microsoft Windows terminal software HyperTerminal 5.1 

Anybus configuration software Anybus LWTool 1.06 Build 39 

Anybus configuration download HMS Firmware download TP 2.8.1.1 

LonWorks configuration software LonMaker for Windows 3.1 

ABC LWTool Manual ABC LWTool Tutorial Manual 1.01 

Anybus LWTool Manual Anybus LWTool Tutorial Manual 1.00 

X-gateway Interface Addendum X-gateway LonWorks Interface 
Addendum  

1.01 

X-gateway User Manual X-gateway User Manual 1.11 

Anybus-S Fieldbus Appendix Anybus-S LonWorks Fieldbus 
Appendix 

1.51 

Anybus-S Drive Profile Appendix Anybus-S Drive Profile LonWorks 
Fieldbus Appendix 

1.10 

Power supply 24VDC n.a. n.a 

Configuration cables n.a. n.a. 

                                        
1 www.echelon.com 
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4 Anybus configuration 
In the following chapters the configuration of the Anybus-S, Communicator and X-gateway are explained. 

4.1 Anybus-S configuration 
The Anybus-S is configured via the host application interface using the mailbox interface. Refer to the 
Anybus-S Fieldbus Appendix for details. 

The LonWorks configuration is done by using Anybus LWTool. The procedure using the Anybus LWTool is 
the same as for the Anybus X-gateway, please see chapter 4.3.2 Anybus LWTool for details. 

Note: When using an Anybus-S LonWorks module you need an adapter interface for downloading the 
configuration, please contact HMS for further information. 
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4.2 Communicator configuration 
The communicator is configured in two steps. 

1 At first the LonWorks configuration is set up in the ABC LWTool. 

2 Secondly the configuration is downloaded using the ABC LWDownload. 

4.2.1 ABC LWTool configuration 

1 Configuring the node properties 

Start the ABC LWTool to configure the Anybus Communicator. Enter the desired name of the configuration 
in the ASCII identification field  as seen below. The additional info field can be used, but this is optional. 

 

1 

Figure 2 Configuring the node options. 

Note: The ProgramID can be set in two different ways, LonMark or ASCII. Select LonMark if you are a 
member of the LonMark organisation and want the configuration to be LonMark compliant. Normal users 
are recommended to use an ASCII programID. 

2 Inserting the variables 

The next step is to add Network Variables. Right click on Network variables and select Add Network 
Variable. 

 
Figure 3 Adding network variables. 
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First enter the name  and type  of the variable. 

Then select the type of direction , In or Out. The Class  of the variable can be left unchanged as it is only 
used if the programID is set to LonMark. Finally the Default Service Type  has to be set. Using 
Acknowledged the node awaits an answer of the data sent. 

 

1

2 

4 5
3 

Figure 4 Configuring the output variable. 

In this case two variables are configured, one input SNVT_speed and one output SNVT_volt_ac are 
configured. 

 
Figure 5 Configuring the input variable. 
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3 Mapping the Modbus registers 

When using the Communicator the Modbus mapping of the variables is done automatically. To view the 
Modbus mapping open the export menu and select Node Documentation. This saves the Modbus mapping to 
an html-file. 

 
Figure 6 Exporting the Node Documentation. 

 
Figure 7 Viewing the Node Documentation file. 

The html-file shows the linking between the Variables and the Modbus registers. 
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4 Exporting the configuration file 

The next step is to export the configuration file. Open the Export menu and select Configuration file. 

 
Figure 8 Exporting the configuration file. 

Name the configuration file and click on save. 

 
Figure 9 Saving the configuration file. 

www.anybus.com HMS Industrial Networks AB 

  

Page 10 (42) 

 



How to configure an Anybus LonWorks module with LonMaker for Windows 

SCM-7032-035 

Rev 1.02 

4.2.2 Configuration download 

Now the configuration is saved and is to be downloaded to the Anybus module. Firstly, start the ABC 
LWDownload and use the desired Modbus settings. 

 
Figure 10 Configuring the Modbus settings. 

In this case EIA-232 is used, since ModScan32 is used from a PC to set values to the registers. 

Secondly open the file menu and select Open. 

 
Figure 11 Opening the file menu. 
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Select the configuration file to be opened. 

 
Figure 12 Selecting the configuration file. 

Also select which COM port to use. 

 
Figure 13 Selecting the COM port for downloading the configuration file. 

Then press Start to download the configuration. 
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If the download is successful the dialogue window shown below appears. 

 
Figure 14 The download program after successful downloading. 
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4.3 Anybus X-gateway configuration 
The configuration of the X-gateway is described in three sections. 

1. Firstly the X-gateway is configured by the Terminal interface. 

2. Secondly the LonWorks configuration is done using the Anybus LWTool. 

3. Finally the configuration is downloaded using the HMS Firmware Download TP. 

4.3.1 Terminal interface 

Use the HyperTerminal on a PC to configure the X-gateway. Connect a serial cable between the PC and the 
config port on the X-gateway. Start the HyperTerminal and open the “File” menu and click on new, choose 
the desired COM port and then click on OK. The following window will appear. 

 
Figure 15 Configuring the connection in the HyperTerminal. 

Make sure the settings are identical to those shown in the window above. Alternatively download a 
HyperTerminal session file from the HMS website2, double click on it and select COM port. 

                                        
2 www.anybus.com 
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Connect and press ESC and the following menu will appear. 

 
Figure 16 Anybus X-gateway main menu. 

Press 6 and enter the desired configuration. 

The figure below shows an example; in this case a LonWorks Slave to Ethernet IP Slave X-gateway is used. 2 
bytes of I/O data on the Ethernet-IP side is configured. The I/O data on the LonWorks side is always 
configured to the maximum size of 512 bytes. 

 
Figure 17 The X-gateway configuration. 
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4.3.2 Anybus LWTool 

The LonWorks configuration is done using the Anybus LWTool software.  

1 Configuring the node properties 

Start the Anybus LWTool to configure the Anybus X-gateway. Enter the desired name of the configuration in 
the ASCII identification field  as seen below. The additional info field can be used, but this is optional. 

 

1 

Figure 18 Configuring the node options. 

2 Inserting the variables 

The next step is to add Network Variables. Right click on Network Variables and select Add Network 
Variable. 

 
Figure 19 Adding network variables. 
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First enter the name  and type  of the variable. 

Then select the type of direction , In or Out. The Class  of the variable can be left unchanged as it is only 
used if the programID is set to LonMark. Finally the Default Service Type  has to be set. Using 
Acknowledged the node awaits an answer of the data sent. 

 

1

2 

543 

Figure 20 Configuring the input variable. 

In this case two variables are configured, one input SNVT_volt_ac and one output SNVT_speed are 
configured. 
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3 Mapping the Modbus registers 

When using the X-gateway the Modbus mapping of the variables can be done manually or automatically. 
Open the Tools menu and select Set Memory Mapping to open the Modbus mapping dialogue. 

 
Figure 21 Opening the Set Memory Mapping dialogue. 

In this case Autogenerate is used by clicking the Autogenerate Memory Mapping button, but the mapping 
can be done manually if desired. 

 
Figure 22 Setting the Memory Mapping. 
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4 Exporting the configuration file 

The next step is to export the configuration file. Open the Export menu and select Configuration file. 

 
Figure 23 Exporting the Configuration File. 

Name the configuration file and click on save. 

 
Figure 24 Saving the configuration file. 
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4.3.3 Configuration download 

The next step is to download the configuration. 

1 Starting the Firmware Download program. 

To download the configuration, start the HMS Firmware Download TP program. 

 
Figure 25 Viewing the Firmware Download window. 

2 Setting the Interface 

Then select the desired Interface. Open the Settings menu and select Change Interface. 

 
Figure 26 Opening the Change Interface dialogue. 

In this case the X-gateway is selected. 

 
Figure 27 Selecting the type of Interface. 
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3 Setting the Path 

Open the settings menu and select Change Path. 

 
Figure 28 Opening the Path dialogue. 

Firstly select the Fieldbus Interface as seen below. 

 
Figure 29 Selecting the download target. 

In this case the Ethernet Transport Provider is used since the X-gateway has an Ethernet connection. In 
other cases you can use the serial transport provider and connect a serial cable to the config port on the X-
gateway. If you do not have configured any transport path before click on the Create button and follow the 
steps in the dialogue windows. 

 
Figure 30 Selecting the type of transport path. 
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Then open the Settings Info tile and make sure the settings are OK. 

 
Figure 31 Checking the download settings. 

4 Downloading the configuration file 

After checking the settings, open the File menu and select load to open the configuration file to be 
downloaded. 

 
Figure 32 Opening the Load dialogue. 

 

1 

Figure 33 Selecting program mode. 

Make sure the Program Mode is selected to Configuration . Then press the Start button. In the dialogue 
appearing also select the correct slot, the power connector is located at the upper slot. 
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5 LonWorks configuration 
To configure the LonWorks network start the LonMaker for Windows. In this case a test network consisting 
of the Anybus Communicator and the Anybus X-gateway has been used. Also one input and output variable 
is configured for both devices. 

Input 

Input 

Output 

Output 

Variable connection  

 

 

 
Figure 34 Variable connection. 

1 Configuring a new network 

Click on the New Network button. 

 
Figure 35 Creating a new network. 
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Figure 36 Configuring the network properties. 

Enter a name for the network and change the paths if necessary. Then click on next. 
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2 Configuring the network properties 

 

2 

1 

Figure 37 Configuring the Network Interface. 

Chose the LON Interface  to be used. The name is depending on what kind of interface is installed on the 
PC, for example USB-stick, PCI-card etc. If the PC is connected to the network, mark the box Network 
Attached . Then click on next. 

 
Figure 38 Selecting Management Mode. 

Select Onnet or Offnet management mode and click on next. Using Onnet changes has have immediate effect 
on the device. 
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3 Selecting the Plug-Ins 

 
Figure 39 Selecting Plug-Ins to be used. 

In the dialogue window the Report Generator can be removed if not used. In other cases just click on next. 
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4 Adding devices 

The LonMaker window with empty network. Drag and drop the Device icon to add a new device. 

 
Figure 40 Adding devices. 

In the next dialogue window enter a Device Name  and mark the box Commission Device . 

 

1

2 

Figure 41 Naming and Commissioning the device. 
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5 Device properties 

 
Figure 42 Setting the Interface Definition. 

Next select how the Interface Definition is to be set up. In this case Upload From Device is used. This loads 
the definition from the node. 

Using Load XIF the definition is retrieved from the selected XIF-file. This alternative can be used when 
setting up the configuration offline. 

Using an existing template can be useful when installing several nodes of the same type. In that case the 
nodes will be configured for the same variables, but the linking can be made different. 

 
Figure 43 Specifying the Device Channel. 

In the above dialogue select the Channel the device is to be connected to. Auto-Detect is used in this case. 

www.anybus.com HMS Industrial Networks AB 

  

Page 28 (42) 

 



How to configure an Anybus LonWorks module with LonMaker for Windows 

SCM-7032-035 

Rev 1.02 

6 Specifying identification 

 
Figure 44 Specifying the Device Properties. 

If you want to specify the physical location for better understanding, it is possible to enter a description in 
the Location field. In other cases, just click on the next button. 

 
Figure 45 Selecting the method of  identification. 

Select to identify the device by Service Pin or Manually. It is recommended to use the Service Pin. 
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7 Specifying the initial state 

 
Figure 46 Loading the Application Image (not applicable using the Anybus device) 

Click on next in this dialogue. 

 

1 
2

Figure 47 Specifying the initial state of the Anybus device. 

In this dialogue you can enter the initial State of the Config Properties and the Source of the Configuration 
Property Values. In this case Online  and Current values in the device  is used. This means the device will 
go online after a restart and will use the current values in the device. Then click on Finish. 
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8 Identifying the device 

 
Figure 48 Identifying the device. 

Press the service-pin and several windows will appear. 

 
Figure 49 Uploading the device template. 

The window above is the last window shown in the Service-pin dialogue. After a successful upload the 
network will be updated. 
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9 Creating graphical shapes for the variables 

After adding the Anybus X-gateway as well, the network will now look like below. The next step is now to 
link the variables. 

 
Figure 50 Viewing the network after the Anybus Communicator and X-gateway has been added. 
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Figure 51 Inserting the Functional Block.  

Drag and drop the Functional Block to the network. This will show the network variables for the device 
selected. 

 
Figure 52 Selecting the name of the device. 

The window above will then appear. Select the name of the device, in this case X-gateway. 
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1

2 

Figure 53 Configuring the properties of the Functional Block. 

Enter a name for the Function Block  and mark the box Create shapes for all network variables . The 
shapes shows the network variables, SNVT:s, graphically. Perform this sequence for all devices on the 
network. 
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10 Linking the variables 

 
Figure 54 Viewing the network after inserting the Functional Blocks. 

The network after both function blocks has been added. 
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Figure 55 Opening the Connect dialogue. 

The next step is to connect the variables. Mark the Function Blocks and right click and select Connect. This 
will make it possible to link the variables associated with the Function Blocks selected. 
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11 Configuring the linking 

 
Figure 56 Configuring the Hub, the source varaible. 

Begin with selecting the hub, the output or if you like the source variable. This will be linked to the selected 
Target, the input variable. 
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Figure 57 Configuring the Target, the destination variable. 

Then select the desired Target, the output variable. To execute the linking, click on Add. Repeat the 
procedure for the rest of the network variables. End by clicking on OK. 
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Figure 58 Viewing the network after the linking has been done. 

The network will now look like above. The network variables are linked according to the figure. The 
network is now ready to be tested. 

Note: It is important to make sure the network configuration is saved correctly before commissioning the 
network. Restart the device or right click on the node in LonMaker for Windows and select Manage. Then 
press offline and then online. If the configuration is saved correctly the node will go online again, otherwise 
the node will be red marked. 

The LonMaker for Windows saves all changes to the network if using the online mode. The procedure for 
saving the configuration is going offline, downloading changes then sending an online message. If this online 
message is missed the configuration will not be saved. When trouble shooting this can in some cases be the 
problem. 
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6 Testing 
The testing of the network can be done after finishing the configuration. In this case the Anybus 
Communicator connected to the X-gateway is used for test purpose. At first some values are written to the 
output variables using ModScan32. The input variables are then monitored using the Browse function in 
LonMaker for Windows. 

6.1 Writing values using ModScan32 
At first some values are to be written to the LonWorks variables in the Anybus X-gateway and the Anybus 
Communicator. The easiest way to write values is using ModScan32 or a similar program. This assumes the 
X-gateway supports Modbus on the other network side. 

 
Figure 59 Writing values to the Modbus holding register of the X-gateway. 

At first the output variable of the X-gateway is written. Open the Connection menu and select connect. Using 
an X-gateway with Ethernet connection, as in this case, it is possible to connect using the Remote TCP/IP 
Server. Then write a value to the output variable at holding register 1. 

 
Figure 60 Writing values to the Modbus holding register of the Communicator. 

Similarly the Anybus Communicator is connected to the ModScan32 software. In this case select the desired 
COM-port and connect. Then write a value to the output variable at holding register 1. 
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6.2 Monitoring using LonMaker for Windows 
Switch to LonMaker for Windows again. Mark the devices of interest, right click on one of them and select 
Browse. This opens up the monitor function. 

 
Figure 61 Opening the Browse window. 

 
Figure 62 Monitoring all of the variables. 

To monitor, right click in the list and select Monitor All On. 
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To change the format of the value right click in the list and select Change Format. 

 
Figure 63 Changing the format of display of the value. 

 
Figure 64 Selecting the type of format. 

Select Built-in data types and then the desired type of data. Raw (Hex, Packed) is selected in this case to get 
the same display format as in ModScan32. 

The input variables can now be monitored as seen below. 

 
Figure 65 Monitoring the input and output variables. 
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